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Cieľ manuálu 

Tento dokument popisuje jednotlivé procesy a čiastkové úlohy potrebné pre vypracovanie zadania. 

Najprv namodelujeme relačnú databázu, vytvoríme a naplníme databázu, vytvoríme analytické 

prostredie a dátovú kocku, vykonáme analýzy pomocou programu Oracle AWM a MS Excel. Cieľom 

zadania je vypracovať analýzy na zvolených dátach.  

Tento návod je primárne určený na operačný systém Windows. Súbor používaných nástrojov je 

dostupný aj pre iné OS. Postup nastavenia prostredia sa môže odlišovať.  
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1. Príprava prostredia 

Pre vypracovanie zadania potrebujeme tieto nástroje: 

- Microsoft Office – Excel, Word 

- Oracle – SQL Developer a modul Data Modeler, Analytic Workspace Manager 

Sťahovanie a inštalovanie balíka Office od Microsoft nie je v tomto dokumente opísané.  

1.1. Získavanie Oracle nástrojov 

V tejto podkapitole opisujeme kde a ako stiahnuť softvér. Na sťahovanie softvéru od spoločnosti 

Oracle máme viacero možnosti. Na webovom sídle predmetu nájdeme inštalačné súbory pre tieto 

nástroje. Nástroje môžeme stiahnuť aj z webových stránok spoločnosti Oracle.  

1.1.1. Oracle SQL Developer 

Program SQL Developer stiahneme z webu: 

- www.oracle.com/database/sqldeveloper/technologies/download 

Najlepšie je vybrať verziu aj s balíčkom JDK. Nie je tak potrebné samostatne inštalovať Java Runtime 

Enviroment. Môže byť vyžadované prihlásenie resp. registrácia. Použijeme školský e-mail na 

registráciu. Stiahne sa nám súbor s príponou zip. Ten extrahujeme, vnoríme sa do priečinka 

sqldeveloper, inicializáciu spustíme kliknutím na sqldeveloper.exe 

 

Obr. 1 Výber balíčka SQL Developer 

 

http://www.oracle.com/database/sqldeveloper/technologies/download
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Pri prvom spustení, dostaneme otázku o importe dát z predošlej verzie. Stačí kliknúť na No. Otvorí 

sa okno programu SQL Developer, význam časti je opísaný v podkapitole 1.2.1. 

 

Obr. 2 Import dát, počas prvej inicializácie 

1.1.2. Oracle OLAP Analytic Workspace Manager 

Podobne ako pri inštalácií SQL Developera, prejdeme na web spoločnosti Oracle: 

- edelivery.oracle.com 

Potrebujeme sa prihlásiť resp. registrovať. Registrácia je bezplatná.  

 

Obr. 3 Web Edelivery od spoločnosti Oracle 

 

http://www.edelivery.oracle.com/
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Po prihlásení, sa nám ukáže obrazovka pre vyhľadávanie súborov. Postupujeme nasledovne: 

1. do poľa pre vyhľadávanie napíšeme Oracle Database 

2. klikneme na tlačidlo Search 

3. zobrazí sa zoznam výsledkov, vyberieme si najvyššiu verziu (prvý riadok ako na Obr. 4) 

4. v pravom hornom rohu klikneme na Continue 

 

Obr. 4 Vyhľadávanie softvéru 

Na nasledujúcej obrazovke: 

1. vyberieme len Oracle Database Client 

2. vyberieme platformu (Microsoft x64) 

3. klikneme na Continue 

 

Obr. 5 Výber balíčka a platformy 
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Na tejto obrazovke si vyberieme základnú verziu a klikneme na zelený názov zip súboru. Začne sa 

sťahovanie. 

 

Obr. 6 Výber správneho súboru 

Balíček extrahujeme, prejdeme do priečinka client a spustíme súbor setup.exe. Spustí sa proces 

inštalácie, postupujeme nasledovne: 

1. vyberieme typ inštalácie – Custom 

2. klikneme na Next 

 

Obr. 7 Výber typu inštalácie 
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3. necháme možnosť – Use Windows Built-in Account  

4. klikneme na Next 

 

Obr. 8 Výber používateľa pre priestor Oracle Home 

5. necháme resp. vyberieme si miesto nainštalovania softvéru Oracle 

6. klikneme na Next 

 

Obr. 9 Výber miesta uloženia softvéru Oracle 
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7. v zozname nájdeme a vyberieme – OLAP Analytic Workspace Manager and Worksheet 

(možnosť Oracle SQL Developer nevyberáme, je to iba command line verzia) 

8. klikneme na Next 

 

Obr. 10 Výber OLAP AWM 

9. klikneme na Install 

 

Obr. 11 Sumarizácia a spustenie inštalácie 
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10. po úspešnej inštalácií, klikneme na Ok 

 

Obr. 12 Oznam o úspešnej inštalácií 

11. inštalátor ukončíme kliknutím na Close 

 

Obr. 13 Ukončenie inštalátora 

Program AWM nájdeme v ponuke štart, v priečinku Oracle – (názov klienta) a spustíme. Popis okna 

programu AWM je v podkapitole 1.2.2. 
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1.2. Doplnkové informácie 

V tejto časti si stručne opíšeme prostredie programu SQL Developer a Analytic Workspace 

Manager. Dokumentáciu pre SQL Developer je možné nájsť na webe: 

- docs.oracle.com/en/database/oracle/sql-developer 

1.2.1. Oracle SQL Developer 

Prostredie sa skladá z viacerých častí: 

1. horné menu obsahuje v prvom riadku, fixné položky, cez ktoré ovládame program, 

otvárame navigátor nástroja, prehliadač a pod. Spodná časť menu obsahuje súbor 

nástrojov, ktorý sa mení v závislosti na otvorený navigátor resp. aplikáciu v časti 3 (Data 

Modeler obsahuje iné ikony ako napr. SQL Worksheet) 

2. v ľavej časti obrazovky máme panel v ktorom nájdeme spojenia, reporty, navigačné okno 

alebo prehľadávač objektov. Táto časť sa mení, podľa toho aký nástroj si vyberieme 

v hornom menu View. Položky majú základnú sadu nástrojov, sú zobrazené pomocou 

stromovej štruktúry a pomocou myši a pravým tlačidlom vyvoláme zoznam s možnosťami 

nad konkrétnym objektom 

3. v tejto časti aktuálne vidíme úvodnú obrazovku. Po pripojení sa k databáze uvidíme 

prostredie SQL Worksheet, pre editáciu a spustenie SQL dopytov. Pri práci s Data 

Modelerom uvidíme v tejto časti tabuľu, ktorá graficky znázorňuje entity a vzťahy.  

 

Obr. 14 Základný popis SQL Developera 

https://docs.oracle.com/en/database/oracle/sql-developer
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1.2.2. Oracle OLAP Analytic Workspace Manager 

Prostredie programu AWM je jednoduchšie ako prostredie SQL Developera. Staršiu verziu 

dokumentácie nájdeme na: 

- docs.oracle.com/en/database/oracle/oracle-database/19/olaug/getting-started-oracle-

olap.html 

Okno sa skladá z horného menu, ľavej časti, a hlavnej časti: 

1. horné menu, nemá veľa funkcionality, vieme zavrieť program, vyvolať nastavenia programu 

a použiť vstavaného pomocníka 

2. ľavá časť, obsahuje stromovú štruktúru spojení, analytických prostredí, dimenzií, kociek 

a pod. Tvorba, manipulácia a mazanie objektov sa uskutočňuje pomocou myši a pravého 

tlačidla. 

3. hlavná časť programu obsahuje, podrobnejšie informácie o objekte, umožňuje rýchlu 

editáciu vytvoreného objektu, mapovanie objektov a pod.  

 

Obr. 15 Základný popis AWM 

 

 

https://docs.oracle.com/en/database/oracle/oracle-database/19/olaug/getting-started-oracle-olap.html
https://docs.oracle.com/en/database/oracle/oracle-database/19/olaug/getting-started-oracle-olap.html
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1.2.3.  Chybové hlášky a ich význam 

V tejto časti sú uvedené niektoré chybové hlášky a ich význam. Tieto chyby sú rovnaké pre SQL 

Developer a AWM. Ak pri pokuse o pripojenie dostaneme chybu: 

- IO chyba: The Network Adapter could not establish the connection  

- Vendor code 17002 

Znamená to, že nemáme VPN a nachádzame sa mimo školskej siete alebo je chyba na strane 

servera. 

Pri nesprávnom mene dostaneme chybu: 

- ORA-01017: invalid username/password; logon denied 

- Vendor code 1017 

Pri nesprávnom hesle dostaneme chybu:  

- ORA-01005: null password given; logon denied 

- Vendor code 1005 
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2. Návrh a tvorba relačnej databázy v programe SQL Developer 

Táto kapitola obsahuje postup pre tvorbu a uloženie dátového modelu, pridanie pripojenia 

k databáze, nahranie dátového modelu pomocou skriptu DDL a vloženie dát do databázy. 

2.1. Modul Data Modeler 

Pre vyvolanie dátového dizajnéra klikneme v hornom menu na View → Data Modeler → Browser. 

V ľavej časti sa otvorí Browser, v ktorom bude prázdny dizajn s názvom Untitled_1. 

 

Obr. 16 SQL Developer – Data Modeler 

2.1.1. Uloženie dátového modelu 

Pred samotnou prácou na dizajne, si môžeme uložiť dizajn. V panele Browser, použijeme pravé 

tlačidlo myši pre kliknutie na názov Untitled_1. Zo zoznamu vyberieme Save Design. 

 

Obr. 17 Uloženie dizajnu 

Dizajn sa uloží ako súbor s príponou dmd a priečinok súborov, ktorý obsahuje jednotlivé objekty, 

obrázky, poznámky, popisy a pod. Ak sa pozrieme na čerstvo vytvorený a uložený dizajn, vidíme že 

máme vytvorený prázdny dizajn Relational_1. 
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Obr. 18 Prázdny dizajn 

2.1.2. Otvorenie a editácia modelu 

Panel Browser má záložku Relational Models, v ktorej vieme vytvoriť nový model alebo otvoriť už 

existujúci model. Pre zobrazenie, klikneme na model pravým tlačidlom myši a vyberieme možnosť 

Show. Rovnaký postup platí aj pre logický model, ktorý je reprezentovaný záložkou Logical Model. 

 

Obr. 19 Otvorenie editora dizajnu 

Tvorba dizajnu môže začínať najprv vytvorením logického modelu a následne vygenerovaním 

relačného (fyzického) modelu alebo najprv vytvorením relačného modelu a následne 

vygenerovaním logického modelu. 

Logický model reprezentuje entity a vzťahy medzi nimi. Je určený pre potreby podniku. Fyzický 

model, je už priamo naviazaný na konkrétny typ databázy a definuje akým spôsobom budú uložené 

dáta. Budeme používať databázu od Oracle. Môžeme začať modelovať fyzický model. 
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2.1.3. Tvorba tabuliek 

Najprv začneme pridávať tabuľky. V hornom menu sa nám rozšíril zoznam ikon. Pre pridanie tabuľky 

klikneme na ikonu New Table (Obr. 20). Kurzor sa zmení na znak +. Klikneme na ľubovoľné miesto 

a otvorí sa nové okno (Obr. 21) v ktorom budeme definovať tabuľku. 

 

Obr. 20 Pridanie tabuľky 

Základom pre vytvorenie tabuľky je vloženie názvu v General → Name a následne v záložke 

Columns špecifikujeme stĺpce tabuľky.  

 

Obr. 21 Editácia tabuľky 

V každom stĺpci definujeme jeho názov, dátový typ (zvolíme Logical), zdrojový typ (podľa dát) 

a ďalšie vlastnosti ako primárny kľuč (PK) alebo povinnosť vloženia (Mandatory). Každá tabuľka 

musí mať primárny kľúč, vlastnosť povinné sa automaticky vyberie, pretože každý riadok v tabuľke 

musí byť selektovateľný a bez vloženej hodnoty by to nebolo možné. Stĺpec pridávame pomocou 
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zeleného znaku +. Stĺpce vieme aj mazať, presúvať, kopírovať, komentovať alebo označiť za 

zastaralé.   

Zmeny uložíme znovu kliknutím na + (Obr. 22 krok 1) alebo na tlačidlo Apply (Obr. 22 krok 6) 

a ukončíme cez tlačidlo Ok. Ak je potrebné vytvoriť resp. upraviť pohľady, indexy a iné, editor 

tabuľky otvoríme dvojklikom na tabuľku v dizajne. 

 

Obr. 22 Pridávanie a editácia stĺpcov 

Ukážková tabuľka, v ktorej budú uložené informácie o dátume je zobrazená na Obr. 23 nižšie. 

 

Obr. 23 Tabuľka dátumov 

Tento postup zopakujeme aj pre ostatné tabuľky, ktoré budú neskôr reprezentovať dimenzie 

a fakty. Pri ukladaní textov, musíme použiť dostatočne veľký počet znakov, na uloženie týchto 

textov. Pri tabuľke faktov, vytvoríme len základné stĺpce. Cudzie kľúče, si vieme vytvoriť ručne, 

alebo sa vygenerujú pomocou pridania vzťahu. Generovanie cudzích kľúčov si ukážeme v 2.1.4. 
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Obr. 24 Dátový model bez prepojení 

2.1.4. Tvorba vzťahov 

Vytvorené tabuľky je potrebné poprepájať. V hornom menu nájdeme ikonu New Foreign Key (kľúč 

s šípkou). Kliknutím na ikonu sa zmení kurzor na znak + s čiarou. Teraz potrebujeme definovať 

začiatok a koniec čiary. Najprv klikneme na tabuľku reprezentujúcu dimenziu a potom na tabuľku 

faktov. Ukážku vidíme na Obr. 26 nižšie. 

 

Obr. 25 Pridanie vzťahu 

 

Obr. 26 Prepojenie dimenzie MIS_DATUM s faktom MIS_FAKT 
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Otvorí sa nové okno, v ktorom je dôležité skontrolovať prvé 3 riadky, prípadne si môžeme zmeniť 

názov vytvoreného stĺpca v tabuľke faktov. Ak sme spokojný s nastavenými parametrami, 

vytvorenie spojenia potvrdíme kliknutím na Ok. 

 

Obr. 27 Editácia parametrov vzťahu medzi MIS_DATUM a MIS_FAKT 

Medzi tabuľkami vznikla šípka. Pri tabuľke dimenzie (dátum) sa objavil čierny trojuholník a pri fakte 

sa objavil znak reprezentujúci kardinalitu jeden alebo viacero záznamov. V tabuľke faktov je cudzí 

kľúč zapísaný a na začiatku stĺpca s cudzím kľúčom je písmeno F. Rovnako postupujeme aj pri 

prepájaní zvyšných tabuliek. 

 

Obr. 28 Vygenerovaný cudzí kľúč 
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2.1.5. Tvorba logického modelu 

Logický model môžeme samostatne vytvoriť (ak nemáme fyzický model) alebo ho vygenerujeme 

z fyzického modelu. Na vygenerovanie stačí v hornom menu kliknúť na ikonu Engineer to Logical 

Model (dvojitá šípka) alebo v prehliadači klikneme pravým tlačidlom na vyvolanie menu 

a vyberieme rovnako pomenovanú možnosť.  

 

Obr. 29 Generovanie logického modelu – spôsob č. 1 

 

Obr. 30 Generovanie logického modelu – spôsob č. 2 

Otvorí sa nové okno v ktorom vieme skontrolovať alebo vybrať, ktoré objekty sa použijú pre 

transformovanie do logického modelu. Potom len klikneme na Engineer.  

Podobne vieme vytvoriť z logického modelu fyzický model. Jediný rozdiel je, že v prehliadači 

klikneme na logický model, pravým tlačidlom vyvoláme menu a vyberieme Engineer to Relational 

Model alebo v hornom menu klikneme na symbol dvojitej šípky, smerujúcej vpravo. 
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Obr. 31 Editácia objektov pri generovaní modelu 

2.1.6. Tlač modelu 

Pred exportom môžeme v okne dátového modelu kliknúť pravým tlačidlom a vybrať možnosť 

Resize to Visible na automatické upravenie vzhľadu. Vizuálny export logického alebo fyzického 

modelu získame, ak v hornom menu vyberieme File → Data Modeler → Print Diagram a vyberieme 

si typ súboru aký potrebujeme. Pre fyzický model je postup rovnaký. 

 

Obr. 32 Tlač modelu 
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2.1.7. Export DDL skriptu 

Pred exportom sa prepneme do fyzického modelu. Na exportovanie máme viacero možnosti. Prvá 

možnosť sa nachádza v hornom menu ako tretia ikona od konca s popisom Generate DDL. 

 

Obr. 33 Generovanie DDL – spôsob č. 1 

V novom okne si nastavíme parameter, verziu databázy. Spustenie DDL staršej verzie by nemal byť 

problém aj na novšej verzií ale radšej konzultuj s cvičiacim. Následne stlačíme Generate. Otvorí sa 

nové okno v ktorom stačí stlačiť Ok. DDL skript vieme skopírovať, upraviť alebo uložiť kliknutím na 

Save. 

 

Obr. 34 Editácia DDL 
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Druhá možnosť je označiť fyzický model kurzorom resp. stlačením kombinácie kláves Ctrl + A, potom 

pravým tlačidlom myši vyvoláme menu a vyberieme možnosť DDL Preview. Nevieme ale zmeniť 

verziu databázy ani exportovať skript do súboru, vieme len editovať a skopírovať skript. 

 

Obr. 35 Generovanie DDL - spôsob č. 2 

 

Obr. 36 Náhľad DDL skriptu 

Pomocou DDL skriptu vieme spätne importovať model (File → Data Modeler → Import → DDL File), 

ak sa nám poškodí alebo stratíme súbor s príponou dmd. 
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2.2. Pripojenie a tvorba databázy 

Táto časť pozostáva z vytvorenia pripojenia k databáze, vytvorenia databázy pomocou DDL resp. 

SQL skriptu a nakoniec vloženia dát do vytvorenej databázy. Budeme pracovať v programe Oracle 

SQL Developer. Pripojenie na školský databázový server sa musí uskutočniť s rámci siete TUKE alebo 

s použitím VPN prístupu. Pre informácie ako nastaviť VPN prístup navštív web: 

- uvt.tuke.sk/wps/portal/uv/sluzby/vzdialeny-pristup-vpn 

2.2.1. Pridanie pripojenia do SQL Developera 

Máme viacero možnosti. Prvou možnosťou je na Welcome Page kliknúť na Create a Connection 

Manually. Druhá možnosť je v paneli Connections kliknúť na zelené + a vybrať možnosť New 

Database Connection. 

 

Obr. 37 Pridanie pripojenia 

V novom okne je potrebné vyplniť nasledovné položky: 

- Name – vlastné pomenovanie spojenia 

- Username, Password – prihlasovacie údaje 

- Hostname, Port, SID – ip adresa servera, port, inštancia databázy 

Položku Database Type necháme na Oracle, Authentication Type na Default a Connection Type na 

Basic. Pred uložením spojenia, vieme spustiť Test. Ak je všetko v poriadku, v pravom dolnom rohu 

sa objaví Status : Success. Potom stlačíme Save. Príklad vyplnených položiek vidíme na Obr. 38.   

https://uvt.tuke.sk/wps/portal/uv/sluzby/vzdialeny-pristup-vpn
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Obr. 38 Editácia spojenia 

V paneli Connections, klikneme pravým tlačidlom myši a vyberieme možnosť Connect. Ak sme 

neuložili heslo, ukáže sa okno, kde je potrebné vložiť heslo. Ak sa program pripojí k databáze, 

v paneli Connections sa ukážu položky ako Tables, Views a otvorí sa prázdny SQL Worksheet. Ak sa 

položky neukážu a vidíme len Loading... dostaneme niektorú z chýb. Pre podrobnosti o chybách 

pozri podkapitolu  1.2.3 Chybové hlášky a ich význam. 

2.2.2. Tvorba databázy 

Pre vytvorenie databázy máme viacero možnosti. Jedna z možnosti je v paneli Connections kliknúť 

na Tables a z ponuky vybrať New Table. My použijeme iný postup a budeme vytvárať databázu 

pomocou DDL resp. SQL skriptu z Data Modelera. Nájdeme súbor v ktorom je uložený skript na 

vytvorenie databázy. Tento súbor otvoríme cez File → Open alebo skopírujeme a vložíme skript do 

SQL Worksheetu. 

 

Obr. 39 Spustenie skriptu na tvorbu databázy 

Skript môžeme spúšťať postupne po jednotlivých deklaráciách kliknutím na ikonu zeleného 

trojuholníka alebo stlačením kombinácie kláves Ctrl + Enter. V tomto prípade je potrebné kliknúť 

napr. do bloku na vytvorenie tabuľky. Spustí sa všetko až po najbližšiu bodkočiarku. Druhá možnosť 
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je spustiť celý skript kliknutím na druhu ikonu zľava resp. stlačením klávesy F5. Pod editorom SQL 

sa otvorí časť s názvom Script Output, kde vidíme stav vykonania príkazu. Ak nevidíme pridané 

tabuľky, v  paneli Connections pravým tlačidlom klikneme na záložku Tables, a zo zoznamu 

vyberieme možnosť Refresh. Zmeny v databáze sú uložené v tzv. transakcií. Vytvorenie tabuľky sa 

implicitne uloží, ak by sme vkladali údaje napr. pomocou INSERT ROW, potom musíme explicitne 

spustiť príkaz COMMIT na uloženie zmien. 

2.2.3. Import dát zo súborov typu Comma Separated Values 

Pre vloženie dát do databázy máme viacero možnosti, môžeme vykonať import  resp. migráciu dát 

z inej databázy ako MySQL, MariaDB, MSSQL a pod. Môžeme importovať dáta aj zo súboru typu 

JSON resp. XML. V tomto návode opisujeme základný import dát zo súborov s príponou CSV. Pre 

dáta z excelu je postup veľmi podobný. Pre migráciu dáta z inej databázy, je potrebné naštudovať 

konkrétny postup od výrobcu, resp. zvážiť možnosti priamej migrácie databázy, exportu a importu 

pomocou SQL alebo pomocou csv.  

Pre import zo súboru csv, v paneli Connections rozbalíme zoznam Tables, nájdeme tabuľku do 

ktorej ideme importovať, pravým tlačidlom myši vyvoláme ponuku a vyberieme možnosť Import 

Data. 

 

Obr. 40 Spustenie importu dát 

Otvorí sa sprievodca importu dát. Podporuje aj import zo súboru xls. V nasledujúcich obrázkoch 

opisujeme import dát pre tabuľku MIS_DATUM. V prvom kroku klikneme na tlačidlo Browse, 

nájdeme súbor a otvoríme. Ďalej nastavíme parametre hlavičky, preskočenia určitého počtu 

riadkov, hárok a pod. V časti File Contents skontrolujeme vzhľad dát. Pri súbore csv, musíme 

parametre upraviť aby dáta vyzerali ako na Obr. 41. Klikneme na tlačidlo Ďalej. 
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Obr. 41 Import dát – krok 1 

V kroku č. 2 nemusíme nič nastavovať. Iba v prípade že chceme vložiť iba určitý počet záznamov. 

Stačí kliknúť na tlačidlo Ďalej. 

 

Obr. 42 Import dát – krok 2 

V kroku č. 3 si vyberáme, ktoré stĺpce tabuľky chceme importovať. Automaticky sa vybrali všetky. 

Na poradí nezáleží. Klikneme na tlačidlo Ďalej. 
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Obr. 43 Import dát – krok 3 

Štvrtý krok je najdôležitejší. Sprievodca sa najprv pokúsi podľa mena priradiť zdrojové stĺpce 

k cieľovým. Výkričník signalizuje chybu. Popis chyby je v časti Status. Ako vidíme na Obr. 44 nižšie 

cieľovému KVARTAL_SK bol priradený zdrojový KVARTAL_SK a ROK_SK. Na pravej strane musíme 

opraviť priradenie, správnemu stĺpcu. Ak nebudeme mať chyby, klikneme na Ďalej. 

 

Obr. 44 Import dát – krok 4 
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V poslednom kroku, vidíme informácie o importe. Import zahájime kliknutím na tlačidlo Dokončiť. 

 

Obr. 45 Import dát – krok 5 

Po skončení importu, dostaneme hlášku o stave importu. Za vkladaním dát sa automaticky vykonala 

operácia COMMIT. Tento postup opakujeme aj pre ostatné tabuľky, ktoré reprezentujú dimenzie 

a nakoniec importujeme dáta do tabuliek faktov. Ak by sme začali importom do tabuliek faktov, tak 

dostaneme chybu o cudzích kľúčoch.   

 

Obr. 46 Úspešný import dát 
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2.3. Doplnkové informácie 

Ak sa pri modelovaní alebo vkladaní dát vyskytla chyba, budeme musieť vymazať tabuľky alebo 

údaje z tabuliek. Pre vymazanie celej tabuľky môžeme použiť príkaz: 

DROP TABLE table_name; 

 

respektíve (ak dáta z table_name sú používané ako cudzí kľúč v inej tabuľke) 

DROP TABLE table_name CASCADE CONSTRAINTS; 

 

Ak máme tabuľky pomenované rovnakým prefixom napr. MIS_ môžeme si vytvoriť procedúru na 

vymazanie týchto tabuliek. 

BEGIN 

  FOR rec IN 

    ( 

      SELECT 

        table_name 

      FROM 

        all_tables 

      WHERE 

        table_name LIKE 'MIS_%' 

    ) 

  LOOP 

    EXECUTE immediate 'DROP TABLE  '||rec.table_name || ' 

CASCADE CONSTRAINTS'; 

  END LOOP; 

END; 

/ 

 

Pre vymazanie malého množstva údajov alebo s použitím WHERE môžeme použiť príkaz: 

DELETE FROM table_name; 

 

alebo pre väčšie množstvo údajov 

TRUNCATE TABLE table_name; 
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Ak sa pri definícií tabuliek použila vlastnosť ON DELETE CASCADE tak na koniec príkazu TRUNCATE 

napíšeme CASCADE. Bez použitia CASCADE dostaneme chybu: 

SQL Error: ORA-02266: unique/primary keys in table referenced by 

enabled foreign keys 

 

Po použití DELETE, máme možnosť vrátiť zmeny pomocou ROLLBACK. Pre použite ROLLBACK sa na 

pozadí vytvára LOG s údajmi, proces mazania je preto zdĺhavý. Pre permanentné vymazanie 

záznamov musíme použiť COMMIT.  

Po použití TRUNCATE, nemusíme ukladať zmeny cez COMMIT, zmeny sa uložia automaticky, ale 

strácame možnosť vrátiť zmeny cez ROLLBACK. 

Pre manuálne vkladanie údajov použijeme: 

INSERT INTO table_name (column_list) VALUES( value_list); 

 

Po vložení dát musíme manuálne uložiť zmeny pomocou: 

COMMIT; 

 

Ak pri vkladaní dát uprednostníme tabuľku faktov dostaneme chybu ORA-02291 (narušené 

referenčné obmedzenie). To znamená, že sme sa pokúsili vložiť dáta do takej tabuľky, ktorá sa 

odkazuje na cudzí kľúč z druhej tabuľky. Ale v druhej tabuľke nie je taký primárny kľúč s konkrétnou 

hodnotou. Najprv musíme importovať dáta do tých tabuliek, ktoré majú len primárne kľúče 

a následne až do tých, ktoré sa odkazujú na iné tabuľky pomocou cudzích kľúčov. 
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3. Analytické prostredie a analýzy v programe Analytic Workspace 

Manager 

Pre analýzy v program Oracle AWM máme splnený základ. Na už vytvorenej relačnej databáze, 

budeme v tejto kapitole budovať analytické prostredia, dimenzie, úrovne v rámci dimenzií, 

usporiadania úrovní, dátové kocky a merateľné fakty nad ktorými budeme vytvárať analýzy 

a zobrazovať dáta.  

3.1. Tvorba pripojenia k databáze 

Dimenzie, úrovne, hierarchie a kocky, je potrebné niekde uložiť a je potrebné získať pre tieto 

objekty dáta. Začneme tvorbou pripojenia k našej databáze, v ktorej máme uložené dáta. Spustíme 

program AWM a v ľavej časti, klikneme pravým tlačidlom myši na Databases a vyberieme New 

Database Connection. 

 

Obr. 47 Pridanie spojenie k databáze 

Otvorí sa nové okno v ktorom si pomenujeme svoje spojenie napr. MIS. Connection Type necháme 

JDBC thin. Do Connection Information vložíme údaje o databáze v tvare: 

- IP adresa alebo hostname:port:SID 

- napr. 147.232.25.197:1523:mis4 

Potom klikneme na tlačidlo Create. 



FEI  KKUI 

37 

 

Obr. 48 Nastavenie údajov spojenia 

V ľavej časti rozbalíme zoznam, klikneme pravým tlačidlom myši na názov spojenia a z ponuky 

vyberieme Connect Database <názov>. Otvorí sa nové okno do ktorého vložíme používateľské 

meno a heslo. Cube type nemeníme. Klikneme na Ok. 

 

Obr. 49 Nastavenie prihlasovacích údajov 

Automaticky sa rozbalí zoznam, v ktorom pod Schemas je názov databázového účtu v ktorom sú 

položky Analytic Workspaces, Maintenance Scripts, Maintenance Reports a iné. Budeme 

pokračovať v Analytic Workspaces, ktorý si vytvoríme v ďalšej podkapitole. 

 

Obr. 50 Zoznam položiek 
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3.2. Tvorba analytického prostredia 

Budeme pracovať v zozname položiek na ľavej strane. Podobne ako pri tvorbe databázového 

pripojenia, klikneme pravým tlačidlom myši na Analytic Workspaces a vyberieme zo zoznamu 

možnosť Create Analytic Workspace.  

 

Obr. 51 Tvorba analytického prostredia 

Otvorí sa nové okno, v ktorom si zvolíme názov prostredia a klikneme na tlačidlo Create. 

 

Obr. 52 Nastavenie názvu analytického prostredia 

V zozname sa nám ukážu nové položky Dimensions, Cubes, Measure Folders a iné. Pri názve 

prostredia je poznámka attached RW. Táto poznámka informuje o tom, že sme v móde Read and 

Write a vieme vykonávať zmeny v tomto prostredí. Pomocou pravého tlačidla myši si vieme vyvolať 

zoznam možnosti a vybrať si len mód čítania. Pre korektné uloženie zmien je niekedy potrebné 

z tohto menu vybrať možnosť Detach Analytic Workspace resp. Save Analytic Workspace. 

Proces tvorby dimenzie, úrovní, hierarchií a mapovanie dimenzie opakujeme pre všetky dimenzie. 
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Obr. 53 Zoznam položiek analytického prostredia 

3.3. Tvorba dimenzií a úrovní 

V analytickom prostredí potrebujeme vytvoriť jednotlivé dimenzie. Dimenziu vytvoríme ak 

klikneme pravým tlačidlom myši na položku v zozname Dimensions. 

 

Obr. 54 Tvorba dimenzie 

Otvorí sa nové okno, v záložke General je potrebné vložiť názov dimenzie. Ostatné položky ako 

Short Label, Long Label a Description sa vyplnia automaticky podľa názvu dimenzie. Vlastnosti Short 

Description Atribute a Long Description Atribute necháme zaškrtnuté. Dimenziu vytvoríme 

kliknutím na tlačidlo Create. Môžeme naraz vytvoriť aj úrovne pre túto dimenziu, ak prejdeme do 

záložky Levels a pridáme ich názvy. Úrovne vieme vytvoriť, upravovať a mazať aj neskôr. 
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Obr. 55 Nastavenie názvu dimenzie 

Na Obr. 56 nižšie vidíme príklad vytvorených úrovni. Long Label, Short Label a Description sa vyplnia 

automaticky. V iných záložkách nepotrebujeme nič meniť, stačí kliknúť na tlačidlo Create pre 

vytvorenie dimenzie aj s úrovňami.  

 

Obr. 56 Nastavenie úrovní dimenzie, počas tvorby dimenzie 
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Ak sme zabudli pridať úroveň alebo po určitom čase sa rozhodneme zmeniť rozdelenie dát, tak 

potrebujeme pridať úroveň do dimenzie. Rozbalíme zoznam dimenzie a pravým tlačidlom myši 

klikneme na položku Levels a vyberieme zo zoznamu možnosť Create Level. 

 

Obr. 57 Pridanie úrovne do existujúcej dimenzie 

Otvorí sa nové okno v ktorom si zvolíme názov úrovne a klikneme na Create. 

 

Obr. 58 Nastavenie názvu novej úrovne 

3.3.1. Tvorba hierarchie a usporiadanie úrovní 

Úrovne v dimenzií musíme nejakým spôsobom usporiadať. Usporiadanie záleží od dimenzie a dát, 

ktoré reprezentuje. Úrovne musíme usporiadať od najväčšej resp. najvyššej po najmenšiu resp. 

najnižšiu. Pre dimenziu dátum, najvyššie bude sumár predajov za celé obdobie. Nižšie budú predaje 

za jeden rok, kvartál, mesiac a najnižšie bude samotný dátum, ktorý reprezentuje predaje za jeden 

deň. Pri geografickom rozdelení to je podobné. Najväčšií celok resp. najvyšší je krajina. Menším 

celkom sú kraje, okresy a nakoniec mestá resp. obce. 
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Hierarchiu vytvoríme, ak v zozname klikneme pravým tlačidlom myši na Hierarchies a zo zoznamu 

vyberieme možnosť Create Hierarchy.  

 

Obr. 59 Tvorba hierarchie 

V novom okne si zvolíme názov hierarchie a postupne z Available Levels presúvame úrovne do 

Selected Levels. Hierarchií môžeme mať viacero a nemusia obsahovať všetky úrovne. Hierarchiu 

vytvoríme ak klikneme na tlačidlo Create. 

 

Obr. 60 Nastavenie názvu hierarchie a usporiadanie úrovní 
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3.3.2. Mapovanie dimenzie 

Posledným krokom pri tvorbe dimenzií je mapovanie dát. Úrovniam v dimenzií musíme priradiť 

vstupné dáta. Vstupnými dátami pre úroveň je stĺpec v zdrojovej tabuľke. Najprv v zozname 

klikneme na Mappings (krok 1). V druhej časti okna sa otvorí zoznam schém resp. databázových 

účtov. Nájdeme svoj účet a rozbalíme zoznam Tables (krok 2).  

 

Obr. 61 Tvorba mapovania 

Rozbalíme tabuľku, aby sme videli stĺpce. Technikou drag and drop vyberieme názov stĺpca 

a vložíme ho do časti Source Coulmn. Pri najnižšej úrovni vložíme do Member stĺpec 

s identifikátorom a do popisov stĺpec s hodnotami najnižšej úrovne. Pri úrovni ako SPOLU_DATUM, 

nemáme dáta. Vložíme iba ľubovoľný popis ako string (text v úvodzovkách). Úroveň pre ktorú 

nemáme dáta použije prednastavenú funkciu dátovej kocky (SUM) na vypočítanie hodnôt. Zmeny 

uložíme kliknutím na tlačidlo Apply. 

 

Obr. 62 Ukážka mapovania 
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3.4. Tvorba a naplnenie dátovej kocky 

Pre tvorbu dátovej kocky, potrebujeme zmapované dimenzie. Tieto dimenzie spojíme do 

multidimenzionálnej dátovej kocky. Výstupom budú samotné dáta vo forme tabuliek, grafov resp. 

reportov. Proces tvorby dátovej kocky začneme v zozname nášho pracovného prostredia, kde 

pravým tlačidlom myši klikneme na položku Cubes a zo zoznamu možnosti vyberieme Create Cube. 

 

Obr. 63 Tvorba dátovej kocky 

V novom okne v záložke General si zvolíme názov a z Available Dimensions si vyberieme resp. 

presunieme dimenzie, ktoré chceme v dátovej kocke do Selected Dimensions. Klikneme na tlačidlo 

Create.  

 

Obr. 64 Nastavenie názvu dátovej kocky a výber dimenzií 
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3.4.1. Tvorba faktov 

Podobne ako sme pri dimenziách vytvárali úrovne, pri dátovej kocke, si vytvoríme merateľné fakty. 

Fakt je reprezentovaný stĺpcom v tabuľke faktov. Zvyčajne sa jedná o číselne hodnoty, ktoré 

vyjadrujú napr. počet predaných produktov, sumu objednávky a pod. V zozname dátovej kocky, 

nájdeme položku Measures, klikneme pravým tlačidlom myši a zo zoznamu vyberieme možnosť 

Create Measure.  

 

Obr. 65 Tvorba faktu 

V novom okne nastavíme názov faktu a klikneme na tlačidlo Create. 

 

Obr. 66 Nastavenie názvu faktu 
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3.4.2. Mapovanie dátovej kocky 

Posledným krokom, pri tvorbe dátovej kocky je mapovanie. Pri mapovaní používame relačnú 

tabuľku, ktorá obsahuje cudzie kľúče. Tieto cudzie kľúče mapujeme k najnižším úrovniam dimenzií. 

Klikneme na Mappings. V druhej časti okna, nájdeme dáta, ktoré budeme mapovať. Rozbalíme 

tabuľku aby sme mali k dispozícií zoznam stĺpcov tabuľky. Mapujeme len riadky nad položkami Join 

Condition (dolná polovica Obr. 67). Zmeny uložíme kliknutím na tlačidlo Apply. 

 

Obr. 67 Mapovanie dimenzií dátovej kocky 
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3.4.3. Údržba dátovej kocky 

Dátová kocka musí prejsť procesom údržby. V tomto procese, sa vygenerujú vypočítané pohľady, 

ktoré z používateľského hľadiska umožnia rýchle vyhľadávanie v dátach a ich zobrazovanie. Ak sa 

zmenia dáta v jednej alebo viacerých dimenziách, musíme tento proces znovu spustiť. Proces 

údržby spustíme ak pravým tlačidlom klikneme na názov dátovej kocky a vyberieme možnosť 

Maintain Cube. 

 

Obr. 68 Spustenie údržby 

Otvorí sa nové okno, vyberieme objekty a klikneme na Next resp. Finish na spustenie údržby. 

 

Obr. 69 Údržba dátovej kocky – výber objektov 
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V ďalšom kroku sa automaticky zoradia akcie pre každú dimenziu. Pokračujeme kliknutím na Next 

 

Obr. 70 Údržba dátovej kocky – metódy aktualizácie dát 

 

Obr. 71 Údržba dátovej kocky – metódy obnovy dát z pracovného prostredia 
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Vyberieme možnosť Run maintenance task immediately in this session a klikneme na Next. 

 

Obr. 72 Údržba dátovej kocky – parametre spustenia údržby 

 

Obr. 73 Údržba dátovej kocky – uloženie procesu do SQL skriptu 
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Kliknutím na Finish sa spustí proces údržby. Dáta sa vložia a usporiadajú v dátovej kocke. Tento 

proces môže trvať zopár minút. Záleží od množstva dát. V hornom pravom rohu je progress bar, kde 

vidíme počet dokončených krokov. Najdôležitejšia je správa o ukončení. Niekedy sa vyskytne 

grafická chyba a v stĺpci Status ostane text Pending ale ukáže sa správa Maintenance Completed. 

Ak sa nám zobrazí táto správa proces sa skončil úspešne. Môžeme kliknúť na tlačidlo Ok a potom 

na Close.  

 

Obr. 74 Správa o úspešnom ukončení údržby 

3.5. Doplnkové informácie 

Pre analýzu dát v programe AWM, pozri ďalšiu kapitolu. Pre správne uloženie dát je dobré sa 

manuálne odpájať z databázy. Pravým tlačidlom myši klikneme na názov databázy a vyberieme 

možnosť Disconnect. 

Ak sa zobrazí pri odpojení chyba: ORA-34344: Analytický pracovný priestor <NAZOV PROSTREDIA> 

nie je pripojený, tak na vyriešenie chyby v zozname klikneme pravým tlačidlom myši na názov 

pracovného prostredia a vyberieme možnosť Detach. Táto možnosť uloží vykonané zmeny na kocke 

a chyba zmizne. 
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4. Analýza dát  

Dáta môžeme analyzovať viacerými spôsobmi. Najprv si popíšeme analýzu dát v program Oracle 

Analytic Workspace Manager. Na analýzu OLAP vieme použiť BI doplnok do Microsoft Excel alebo 

aj iné desktopové nástroje od iných výrobcov. 

4.1. Oracle AWM práca s Measure Data Viewer 

Najprv sa musíme pripojiť k databáze, otvoriť analytické prostredie. Rozbalíme zoznam Cubes. 

Pravým tlačidlom myši klikneme na názov dátovej kocky a vyberieme zo zoznamu možnosť View 

Data. Otvorí sa nové okno, v ktorom sa zobrazí tabuľka a graf. 

 

Obr. 75 Otvorenie prostredia pre analýzu dát 

4.1.1. Popis pracovného prostredia Measure Data Viewer 

 

Obr. 76 Rozdelenie Measure Data Viewer 



FEI  KKUI 

52 

Na Obr. 76 vidíme, že prostredie je rozdelené na 4 časti. V prvej časti sú nástroje väčšinou na úpravu 

vzhľadu: 

- 1. Query Builder – nástroj v ktorom si vieme vybrať, skryť dimenzie, upravovať, usporiadať 

výber úrovni v dimenziách, nastavovať podmienky a pod. 

- 2. súbor nástrojov pre úpravu textu v hlavičke tabuľky ale aj riadkoch, stĺpcoch či bunkách 

- 3. farba výplne pozadia buniek a farba textu v bunkách 

 

Obr. 77 Editor dát v tabuľke 

Druhá časť okna predstavuje tabuľku s dátami. V časti Položky stránky si nastavujeme dimenzie na 

konštantné hodnoty. Pod touto časťou máme samotnú hlavičku tabuľky a dáta. Rozbaľovanie 

položiek na nižšiu úroveň, vykonávame pomocou šípky (1.) pri popise. Obdĺžniky (2. a 3.) umožňujú 

označiť celý riadok, resp. stĺpec hlavičky a tak aplikovať zmenu vzhľadu na všetky položky. Biely 

štvorec a obdĺžniky vpravo a dole (4.), umožňujú rovnakú funkcionalitu. Kliknutie na štvorec 

umožňuje označiť všetky bunky v tabuľke. 

 

Obr. 78 Nástroje pre grafickú úpravu hlavičky a buniek tabuľky 

Na výmenu dimenzií použijeme modrý obdĺžnik s tromi bodkami. Pomocou techniky ťahaj a pusti, 

vieme vymeniť dimenzie medzi sebou. Pre výmenu dimenzie, klikneme ľavým tlačidlom myši na 

modrý obdĺžnik pri nej a ťaháme ju na miesto dimenzie, ktorá sa nachádza v tabuľke. Miesto 

v tabuľke sa označí sivou farbou, ak pustíme ľavé tlačidlo myši nad týmto výberom, dimenzie sa 

vymenia. Nižšie vidíme stav pred a po výmene dimenzií. 

 

Obr. 79 Výmena dimenzií 
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Podobne ako pre výmenu dimenzií vieme pridať ďalšiu dimenziu medzi už existujúce dimenzie 

v tabuľke. Použijeme znovu techniku ťahaj a pusti. Ľavým tlačidlom myši klikneme na modrý 

obdĺžnik s tromi bodkami pri dimenzií a ťaháme ju smerom do tabuľky. V tabuľke sa ukáže čierna 

čiara, ktorá reprezentuje, medzi ktoré dimenzie, vložíme označenú dimenziu. Po pustení sa 

dimenzia vloží a výsledok vidíme v pravej časti Obr. 80 nižšie.  

 

Obr. 80 Pridanie dimenzie do tabuľky 

Dimenzie vieme meniť resp. odoberať aj vytiahnutím z tabuľky a vložením medzi Položky stránky. 

Tretia časť obrazovky obsahuje viacero editačných možností, zameraných na úpravu grafu: 

- 1. umožňuje schovať tabuľku alebo graf 

- 2. súbor nástrojov na editáciu textu v legende a orientačných hodnôt osí. Môžeme meniť 

farbu písma, farbu pozadia okolia textu, okolia grafu, grafu alebo napr. stĺpcov v grafe. 

- 3. nastavenie typu grafu, ukázanie resp. schovanie legendy, ukázanie resp. schovanie 

vodiacich čiar v grafe, pridanie efektu prechodu farieb alebo pridanie 3D efektu pre objekty. 

 

Obr. 81 Nástroje pre grafickú úpravu grafu 

V štvrtej časti nájdeme samotný graf, ktorý vieme pridať do dokumentácie alebo prezentácie. 

4.1.2. Query Builder 

Pomocou nástroja Query Builder si vieme vyselektovať alebo upraviť dáta. Spustíme ho kliknutím 

na prvú ikonu v pravom hornom rohu alebo prejdeme do File → Query Builder. Otvorí sa nové 

okno. V prvom kroku si definujeme ktoré dimenzie chceme vybrať, resp. ktoré hierarchie si v týchto 

dimenziách vyberáme. Pokračujeme kliknutím na tlačidlo Ďalej alebo ukončíme proces kliknutím na 

Dokončiť. 
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Obr. 82 Query Builder – výber dimenzií 

V druhom kroku, meníme dimenzie. Ak klikneme na dimenziu pravým tlačidlom myši ukáže sa 

zoznam možnosti. Vieme vymeniť dimenziu s niektorou inou, presunúť nad, pod, doprava alebo 

doľava od druhej dimenzie alebo skryť túto dimenziu.  

 

Obr. 83 Query Builder – rozloženie dimenzií 

v treťom kroku, si vyberieme v hornej časti dimenziu, ktorú chceme upraviť. V ľavej časti si 

rozbalíme zoznam. Chceme napr. usporiadaný zoznam mesiacov len za rok 2011. Mesiace vieme 

pomocou kláves Shift alebo Ctrl označiť a presunúť do pravej časti. V pravej časti sú položky, ktoré 
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budú zobrazené v časti Položky Stránky nad tabuľkou resp. v hlavičke tabuľky. Ako vidíme položky 

sú usporiadané od najmenšej po najväčšiu. Abecedný zoznam mesiacov je nesprávny.  

 

Obr. 84 Query Builder – úprava dimenzií 

V pravej časti Vybrané sa preklikneme do karty Členy. V tejto karte máme možnosť ručne 

usporiadať tieto položky technikou ťahaj a pusti. Je dobré uvažovať predom nad poradím položiek. 

Nechceme potom ručne presúvať 200 položiek. V ľavej časti Podmienky si vieme nastaviť napr. top 

10% predajov alebo definovať vlastné podmienky. Rovnako sa presúvajú do časti Vybrané. 

 

Obr. 85 Query Builder – úprava poradia položiek v dimenzií 
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Po tomto kroku môžeme kliknúť na tlačidlo Dokončiť. V poslednom kroku Query Buildera, vidíme 

len zoznam skrytých dimenzií. 

 

Obr. 86 Query Builder – zoznam skrytých dimenzií 

Medzivýsledok môže vyzerať ako napr. na Obr. 87 nižšie. 

 

Obr. 87 Časť medzivýsledku fiktívnej analýzy 

4.2. Analýza pomocou OracleBI Excel 

Doplnok OracleBI, nie je možné použiť s MS Office 365 verziou. Office 365 je odlišná od 

štandardných verzií ako Office 2010 alebo Office 2013. Je možné použiť staršiu verziu ako napr. MS 

Office 2007, ktorý je možné nainštalovať a používať aj na operačnom systéme Windows 11. Na 

webovom sídle predmetu nájdeme inštalačný súbor pre OracleBI doplnok. 
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4.2.1. Inštalácia doplnku 

Pred inštaláciou je potrebné zavrieť všetky otvorené okná balíka MS Office. Inštalačný súbor 

s príponou exe spustíme. V novom okne klikneme na tlačidlo Install. 

 

Obr. 88 Inštalácia OracleBI – krok 1 

V druhom kroku, akceptujeme podmienky používania a klikneme na Continue. 

 

Obr. 89 Inštalácia OracleBI – krok 2 

Následne si vyberieme miesto inštalácie doplnku, nemusíme vykonávať zmeny, stačí kliknúť na Ok. 

 

Obr. 90 Inštalácia OracleBI – krok 3 

Po kliknutí na Ok sa spustí proces inštalácie. inštalátor ukončíme kliknutím na Finish. 
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4.2.2. Pridanie pripojenia k databáze 

Otvoríme MS Excel, v hornom menu nájdeme záložku Doplnky. Nájdeme záložku OracleBI, 

rozbalíme zozname a klikneme na Connections. 

 

Obr. 91 Doplnok OracleBI 

 

Obr. 92 Pridanie pripojenia 

V novom okne klikneme na New, vložíme parametre pripojenia, klikneme na Save a potom na Ok. 

 

Obr. 93 Nastavenie parametrov pripojenia 

Pripojenie je pridané v adresári pripojení. Znovu prejdeme do záložky OracleBI, rozbalíme zoznam 

a vyberieme možnosť New Query. 
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Obr. 94 Vytvorenie dopytu 

V novom okne potrebujeme zadať používateľské meno a heslo. Pripojíme sa kliknutím na tlačidlo 

Connect. 

 

Obr. 95 Nastavenie mena a hesla 

Otvorí sa Query Wizard, v ktorom je možné vyberať dátové kocky, dimenzie alebo hierarchie. Tento 

sprievodca je vzhľadovo podobný ale funkcionalitou rovnaký ako Query Builder v Oracle AWM, 

ktorý sme popísali v kapitole 4.1.2. 

4.2.3. Prostredie 

Prejdením sprievodcu dopytu, dostaneme zostavu s údajmi. Funkcionalita je podobná ako v prípade 

Oracle AWM. Ukážku vidíme na Obr. 96 nižšie.  

 

Obr. 96 Ukážkové dáta v zošite 
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Kliknutím na šípku pri tmavomodrom obdĺžniku, nastavujeme konštantnú hodnotu určitej 

dimenzie. Ak nevidíme položku, ktorú chceme vybrať tak v hornom menu klikneme na Edit Query, 

a vyberieme si z hierarchie položku akú potrebujeme. Nižšie vidíme interaktívnu tabuľku. 

Dvojklikom na položku názvu stĺpca alebo riadka, rozbalíme nižšiu úroveň (drill down), resp. zbalíme 

na vyššiu úroveň (drill up). Výmena dimenzií technikou ťahaj a pusti ako v Oracle AWM nie je 

možná, môžeme tak ale spraviť v editore dopytu. 

4.2.4. Grafy a grafická úprava 

Grafická úprava buniek v tabuľke, resp. tvorba a úprava grafov, prebieha pomocou vstavaných 

nástrojov v programe Excel. Tieto úpravy sú jednoduché, preto ich v tomto dokumente 

neopisujeme. 


